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Цель работы – оценить информативность применения компьютерных программ анализа изобра-
жений для определения формы просветов биологических объектов на примере возрастных изменений 
желез простаты человека в разных структурных дольках органа. 

Материал и методы. Исследовано 37 простат мужчин в возрасте от 17 до 75 лет, с применением 
программы открытого доступа «ImageFiji». Определение формы просветов концевых отделов желез про-
водилось на гистологических препаратах, окрашенных гематоксилином и эозином, фукселином по Hart и 
азокармином по Heidenhain, в переднемедиальной, верхнемедиальной, нижнезадней, нижнебоковой 
дольках правой и левой половин простаты. Для описания формы просветов концевых отделов желез про-
статы использовали диаметр Фере и «характеристики формы», включающие следующие факторы формы: 
округлость, индекс закругленности, индекс компактности. Статистическая обработка полученных данных 
выполнена при помощи пакетов прикладных статистических программ «Microsoft Excel’2007» и Statistica 
10». 

Результаты. Обнаружили, что форма просветов концевых отделов желез в каждой из структурных 
долек простаты с возрастом изменяется не одинаково. 

Заключение. Предложенный способ количественного определения изменений формы просветов 
биологических объектов, основанный на использовании возможностей компьютерной программы анали-
за изображений ImageFiji, информативен при оценке их изменений. Полученные результаты способству-
ют расширению имеющихся в настоящее время научных представлений о возрастных преобразованиях 
желез простаты и могут использоваться как при исследовании возрастных, половых, индивидуальных 
особенностей строения структур человека и животных, так и на этапе предварительной оценки наличия 
патологических изменений. 

 

Ключевые слова: анализ изображений, простата, железы, форма просвета, диаметр Фере. 
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The aim of study was to evaluate the informative value of computer-based image analysis programs for 
determining the shape of lumens of biological objects investigating age-related changes in the human prostate 
glands in various structural lobules of the organ as an example. 

Material and methods. The study included 37 men aged 17-75, whose prostates were examined using 
the open-access program “ImageFiji”. Histological slides stained with hematoxylin and eosin, fuchselin with 
Hart’s modification and azocarmine according to Heidenhain were used to determine the shape of lumens of ade-
nomeres in the anteromedial, upper medial, inferior, lower lateral lobes of the right and left halves of the prostate. 
The Feret diameter and “shape characteristics” were used to describe the shape of the lumens of prostate adeno-
meres; this including the following shape factors: roundness, roundness index, and compactness index. The ob-
tained data were statistically processed using “Microsoft Excel’2007” and “Statistica 10” programs. 

Results. The results obtained demonstrated that the shape of the lumens of adenomeres in each of the 
structural lobes of the prostate does not vary in the same manner with age. 

Conclusion. The proposed method for the quantitative determination of changes in the shape of lumens 
of biological objects based on the potentials of “ImageFiji”, a computer program for analyzing images, is consid-
ered to have an informative value when evaluating these changes. The obtained results contribute to the expan-
sion of the current scientific understanding of age-related transformations of the prostate glands and can be used 
both in the study of age, sex, individual structural features of human and animal structures, and at the stage of 
preliminary assessment of the presence of pathological changes. 
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Введение 
 

Современные технологии компьютерно-
го анализа изображений интенсивно внедря-
ются в различные сферы деятельности для 
автоматизированной оценки состояния иссле-
дуемых предметов, структур, в том числе и в 
медицинские исследования [3, 5, 14]. Сущест-
вуют программы оценки качественных (цвет, 
плотность) и количественных (размеры) па-
раметров исследуемых объектов. В биомеди-
цинских исследованиях из количественных 
характеристик традиционно определяют дли-
ну, ширину, толщину, площадь, объем, пери-
метр. Форму объекта относили к качествен-
ным характеристикам, так как при визуаль-
ном определении она являлась понятием 
субъективным и разными исследователями 
могла оцениваться по-разному [1]. Разрабаты-
ваемые в последние годы компьютерные ме-
тоды помогают перевести параметр «форма» 
из качественного в количественный. В мор-
фологии определение формы применяется 
для установления степени развития патологи-
ческих изменений органов, составляющих их 
структур. Установлено, что параметр «форма» 
является важной подсказкой для определения 
наличия, степени тяжести некоторых заболе-
ваний головного мозга [7, 8 9, 11, 16], простаты 
[6, 17, 18], молочной железы [13]. Применение 
методов оценки, основанных на определении 
формы гистологических объектов, позволяет 
использовать микрофотографии или отскани-
рованные изображения гистологических пре-
паратов, окрашенных по различным методи-
кам. Контуры, форма, размеры объектов не 
изменяются в зависимости от метода окраски. 

Цель работы – оценка информативно-
сти применения компьютерных программ 
анализа изображений для достоверного опре-
деления формы просветов биологических 
объектов на примере возрастных изменений 
желез простаты человека. 
 

Материал и методы исследования 
 
Исследование выполнено на гистологи-

ческих препаратах простаты 37 юношей и 
мужчин 17–75 лет, не имевших патологиче-
ских изменений мочеполового аппарата, по-
лученных из фонда кафедры анатомии чело-

века учреждения образования «Витебский 
государственный медицинский университет» 
(табл. 1). 

При помощи микроскопа Leica DM 2000 
с фотонасадкой (Германия) и цифровой каме-
ры «Leica D-LUX 3» (Германия) на окрашен-
ных гематоксилином и эозином, фукселином 
по Hart и азокармином по Heidenhain гисто-
логических срезах всех структурных долек 
простаты, в полях зрения, отобранных мето-
дом случайных чисел, по рекомендациям ру-
ководств по морфометрии, получали фото-
графическое изображение желез [1]. Оценку 
формы просветов желез проводили в перед-
немедиальной, верхнемедиальной, нижнезад-
ней, нижнебоковой дольках правой и левой 
половин простаты. Полученные микрофото-
графии желез простаты обрабатывали в про-
грамме открытого доступа «ImageFiji» [13]. 
В приложении программы имеется набор 
стандартных инструментов, позволяющих 
проводить корректировку изображения для 
улучшения его качества. Этот набор включает 
в себя следующие действия: регулировку кон-
трастности, резкости, яркости и цветности, 
подавление шума, сглаживание, обнаружение 
границ и выделение деталей. 

Определение формы просвета желез 
простаты проведено согласно следующему 
алгоритму: 

1. Калибровка, полученных изображе-
ний с использованием объект-микрометра, 
сфотографированного в микроскопе через тот 
же объектив, что и исследуемые образцы 
(Analyze→Set scale) (рис. 1) 

 

 
Рис. 1. Изображение желез простаты мужчины 
21 года. Переднемедиальная долька. Окраска ге-
матоксилином и эозином.  
 

2. Преобразование изображения в  
8-битовое (Image→Type→8 bit) (рис. 2). Усло-
вие 8-битового типа изображения обязатель-
но для определения порогов при создании 
масок объектов. 

3. Фильтрация изображения (Process 
→Filtres→Guassian Blur…) (рис. 3). Размы-
вающие фильтры применяются для очистки 
изображения от шумов и удаления ненужных 
деталей. Гауссово размытие применяется для 
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Таблица 1 
Распределение материала исследования в соответствии с возрастной группой 

 

Возрастной  
период 

Юношеский  
возраст 

Первый период 
зрелого возраста 

Второй период 
зрелого возраста Пожилой возраст 

Возраст (лет) 17–21 22–35 36–60 61–75 
Число  

наблюдений 7 8 15 7 

 
 

 
Рис. 2. Изображение желез простаты, преобразо-
ванное в 8-битовое. 
 

 
Рис. 3. Изображение желез простаты, обрабо-
танное при помощи фильтра. 
 

устранения мелких дефектов, путем размытия 
изображения. Приведенный пример фильтра 
удобно использовать, когда снимки уже хра-
нятся в базе изображений, а повторение их 
съемки проблематично, или при проведении 
исследований серии снимков с одним и тем 
же неустранимым дефектом. 

4. Установление пределов распознава-
ния (Image→Adjust→Threshold…) (рис. 4). 

5. Создание двоичной маски 
(Process→Binary→Make binary) (рис. 5). 
6. Сохранение полученного изображения в 
формате PNG. 
7. Установление параметров измерения 
(Analyze→Set measurements…). В нашем слу-
чае были выбраны «характеристики формы» 
(Shape descriptors) и «диаметр Фере» (Feret’s 
diameter) (рис. 6). 

Для описания формы просветов исполь-
зовали диаметр Фере и «характеристики фор-
мы», включающие следующие факторы   фор- 

 
Рис. 4. Изображение просвета желез простаты, 
преобразованное с помощью установки пределов 
распознавания. 
 

 
Рис. 5. Изображение просветов желез простаты, 
преобразованное с помощью бинарной маски. 
 

 
Рис. 6. Выбор параметров измерения. 
 

мы: округлость, индекс закругленности, 
индекс компактности [5]. 

Диаметр Фере – это расстояние между 
касательными к контуру изображения, прове-
денными параллельно направлению про-
смотра. В нашем случае для каждого изме-
ряемого просвета выбиралась средняя вели-
чина диаметра Фере. 



Журнал анатомии и гистопатологии. 2019; 8(3) ◊ Journal of anatomy and histopathology. 2019; 8(3) 

92 

Таблица 2 
Показатели формы просветов желез простаты у людей разного возраста (M [1st Qu; 3rd Qu]) 

 

Возрастной  
период 

Отдел 
простаты Диаметр Фере Округлость Индекс закруг-

ленности 
Индекс  

компактности 
AM 170 (118;318) 0.63(0.59;0.69) 0.47 (0.43;0.68) 0.92 (0.81;0.7) 
SM 158 (74;225) 0.63(0.6;0.77) 0.47 (0.4;0.6) 0.84 (0.68;0.93) 
IL 169(117;319) 0.82(0.73;0.96) 0.61 (0.5;0.7) 0.98(0.95;0.9) 

Юношеский 
возраст 

IP 156 (104;231) 0.5(0.49;0.63) 0.48 (0.36;0.8) 0.83 (0.75;0.9) 
AM 177 (106;302) 0.82(0.77;0.96) 0.6 (0.49;0.4) 0.98* (0.9;0.95) 
SM 168(100;296) 0.6(0.59;0.71) 0.47 (0.36;0.62) 0.89* (0.74;0.96) 
IL 211* (170;359) 0.52 (0.42;0.63) 0.46* (0.35;0.6) 0.98 (0.9;0.96) 

Первый период 
зрелого возраста 

IP 199* (128;257) 0.49 (0.44;0.53) 0.43 (0.29;0.5) 0.82 (0.76;0.9) 
AM 206* (177;230) 0.72(0.69;0.84) 0.54 (0.42;0.6) 0.94 (0.83;0.9) 
SM 223*(198;352) 0.6 (0.55;069) 52(0.37;0.6) 0.88 (0.77;0.9) 
IL 241* (139;318) 0.64(0.6;0.75) 0.58* (0.4;0.7) 0.95 (0.7;0.9) 

Второй период 
зрелого возраста 

IP 193 (129;272) 0.41 (0.38;0.5) 0.52 (0.37;0.6) 0.88* (0.78;0.9) 
AM 225 (160;334) 0.72 (0.59;0.8) 0.58 (0.42;0.6) 0.94 (0.82;0.9) 
SM 222 (197;352) 0.6 (0.5;0.67) 0.52 (0.37;0.6) 0.88 (0.77;0.9) 
IL 246 (166;356) 0.66 (0.61;0.71) 0.58 (0.48;0.7) 0.95 (0.78;0.9) 

Пожилой  
возраст 

IP 223 (196;353) 0.6 (0.54;0.66) 0.52 (0.37;0.6) 0.88 (0.78;0.9) 
Примечание: АМ – переднемедиальная долька, SM – верхнемедиальная долька, IL – нижнелатеральная 
долька, IP – нижнезадняя долька; * – отмечены статистически значимые различия по сравнению с преды-
дущим периодом. 

 
Округлость (circularity) просветов кон-

цевых отделов желез определяется по форму-
ле: 

 
 

Значение округлости – это морфомет-
рический параметр, отличающий степень от-
личия фигуры от круга, равное 0, формально 
соответствует бесконечно вытянутому много-
угольнику, значение, равное 1 – идеальному 
кругу. 

Мы сочли целесообразным использо-
вать «индекс закругленности (roundness)», так 
как контуры просветов желез, имеют много 
небольших выпуклостей на поверхности. Как 
известно, в этих случаях периметр увеличива-
ется, и значение округлости принимает более 
низкие значения, тогда как величина индекса 
закругленности не зависит от неровностей 
периметра. 

 
 

«Индекс компактности (solidity)» – отноше-
ние площади контура к площади его выпук-
лой оболочки. 

 
 

8. Измерение производится при помо-
щи инструмента «Волшебная палочка». Сле-
дует учитывать, что некоторая часть просве-
тов некорректно распознана из-за просветов 
сосудов или просветов в участках стромы, не 
являющихся просветом желез. 

9. Выведение полученных результатов 
(Analyse→Tools→RIO Manager) и получаем 
таблицу с данными (рис.7). 

10. Сохранение данных в таблице Excel. 
11. Статистическая обработка данных. 

 
Рис. 7. Использование инструмента «Волшебная 
палочка» и RIO Manager. 
 

Статистическая обработка данных про-
изведена при помощи пакетов прикладных 
статистических программ «Microsoft 
Excel’2007» и Statistica 10». Распределение 
исследуемых показателей статистически зна-
чимо отличалось от нормального (тест Шапи-
ро–Уилка). Полученные результаты оценива-
лись непараметрическими методами матема-
тической статистики (W-критерий Вилкоксо-
на для сравнения двух независимых выборок, 
H-критерий Краскела–Уоллиса для множест-
венного сравнения, post hoc тест Данна с по-
правкой Бонферрони). Результаты представ-
лены в виде M (1st Qu; 3rd Qu), где M – медиа-
на, 1st Qu – первый квартиль, 3rd Qu – третий 
квартиль. 
 

Результаты и их обсуждение 
 

Применение вышеописанного алгорит-
ма расчета характеристик формы выявило 
статистически значимые различия по всем 
исследуемым показателям между железами 
разных структурных долек простаты в преде-
лах возрастного периода, как в первом, так и 
во втором периодах зрелого возраста (табл. 2). 

Различия формы желез и их просветов в 
разных структурных дольках простаты муж- 
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Таблица 3 
Сравнение показателей формы просветов желез простаты в структурных дольках простаты 

мужчин юношеского возраста 
 

Сравниваемые 
отделы Диаметр Фере Округлость Индекс  

закругленности 
Индекс  

компактности 
AM–IL 0.17 <0.05 <0.05 <0.05 
AM–IP 0.15 <0.05 0.78 <0.05 
IL–IP 0.12 <0.05 <0.05 <0.05 

AM–SM 0.09 <0.05 0.9 <0.05 
IL–SM 0.7 <0.05 <0.05 <0.05 
IP–SM 0.33 <0.05 0.23 0.58 

Примечание: АМ – переднемедиальная долька, SM – верхнемедиальная долька, IL – нижнелатеральная 
долька, IP – нижнезадняя долька. 

 
 

Таблица 4 
Сравнение показателей формы просветов желез простаты в структурных дольках простаты 

мужчин первого периода зрелого возраста  
 

Сравниваемые 
отделы Диаметр Фере Округлость Индекс  

закругленности 
Индекс  

компактности 
AM–IL <0.05 <0.05 <0.05 0.47 
AM–IP 0.13 <0.05 <0.05 <0.05 
IL–IP 0.53 0.97 0.14 <0.05 

AM–SM <0.05 <0.05 <0.05 <0.05 
IL–SM <0.05 <0.05 0.7 <0.05 
IP–SM 0.47 <0.05 0.08 <0.05 

Примечание: см. табл. 3. 
 
 

Таблица 5 
Сравнение показателей формы просветов желез простаты в структурных дольках простаты 

мужчин второго периода зрелого возраста  
 

Сравниваемые 
отделы Диаметр Фере Округлость Индекс  

закругленности 
Индекс  

компактности 
AM–IL <0.05 <0.05 0.19 0.64 
AM–IP <0.05 <0.05 0.62 <0.05 
IL–IP <0.05 <0.05 0.17 <0.05 

AM–SM <0.05 <0.05 0.63 <0.05 
IL–SM 0.99 0.9 0.9 <0.05 
IP–SM 0.98 <0.05 0.89 0.91 

Примечание: см. табл. 3. 

 
 

Таблица 6 
Сравнение показателей формы просветов желез простаты в структурных дольках простаты 

мужчин пожилого возраста  
 

Сравниваемые 
отделы Диаметр Фере Округлость Индекс  

закругленности 
Индекс  

компактности 
AM–IL 0.78 <0.05 0.2 0.61 
AM–IP 0.09 <0.05 0.6 <0.05 
IL–IP 0.3 0.42 0.2 <0.05 

AM–SM 0.65 <0.05 0.6 <0.05 
IL–SM 0.99 0.89 0.9 <0.05 
IP–SM 0.97 0.91 0.91 0.92 

Примечание: см. табл. 3. 
 
чин зрелого возраста описаны в научных ра-
ботах [10, 15]. Однако, эти описания основаны 
на визуальной оценке гистологических пре-
паратов и не могут быть оценены методами 
математической статистики. У юношей и 
мужчин пожилого возраста достоверное от-
личие из характеристик формы просветов 
между железами разных долек простаты мы 
установили только для одного параметра – 
индекса компактности. 

Нами также установлено, что форма просве-
тов концевых отделов желез простаты изме-
няется с возрастом. В простате мужчин перво-
го периода зрелого возраста в сравнении с 
юношеским возрастом показатель диаметр 
Фере демонстрирует статистически значимые 
различия формы просвета концевых отделов 
желез (р≤0.05) в нижнебоковой и нижнезад-
ней дольках (табл. 3, 4, 5, 6), а в сравнении с со 
вторым периодом зрелого возраста различия 
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в верхнемедиальной и переднемедиальной 
дольках. 

В первом периоде зрелого возраста в 
сравнении с юношеским и вторым периодом 
зрелого возраста критерий округлость пока-
зал статистически значимое отличие (р≤0.05) 
во всех структурных дольках простаты. Воз-
растные изменения величины желез и их про-
светов в разных дольках простаты на основа-
нии сравнения их линейных размеров в ана-
логичные возрастные периоды ранее уже бы-
ли показаны [2]. Но на основании линейных 
размеров желез авторы не смогли установить 
достоверность изменений формы желез по 
возрастным периодам. 

Таким образом, показано, что в перио-
ды функционального становления и возрас-
тной инволюции простаты мужчин имеются 
изменения не только размеров, но и формы 
желез в разных структурных дольках органа. 
Подобные возрастные преобразования формы 
и линейных размеров просветов желез про 
простаты установлены в процессе развития 
органа в фетальные и неонатальные периоды 
[2, 4, 12]. 
 

Заключение 
 

Использование возможностей компью-
терной программы анализа изображений 
ImageFiji для достоверного определения фор-
мы просветов биологических объектов ин-
формативно при оценке их изменений. Так 
как определение формы просвета объектов 
активно внедряется на этапе предварительной 
оценки наличия патологических изменений в 
органах, данные методы следует использовать 
и при исследовании возрастных, половых, ин-
дивидуальных особенностей строения струк-
тур человека и животных. 
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